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Wow. It may be an understatement
that this year’s meeting was a great
success! We saw record breaking
attendance, with a final count of 207
attendees, including 92 first-time
attendees. The main room was packed
and some sessions were standing room
only. There was a sense of excitement
and engagement throughout the
conference—everyone seemed to feel
that this was a place to be with “our
people.”
Favorite activities returned, such
as the speed networking session,
the exchange forum, and back by
high demand, the dine-around
dinners.
Sixteen posters—an ISMTE
record—were submitted this year
and were displayed during the
conference. Congratulations to
Sarah McCormack and Kimberly
Rhodes from the American Society
for Nutrition (ASN) on receiving
First Place for their poster “ASN’s
Interactive Peer Review Checklist:
Regulating the Peer Review
Process.” Visit the ISMTE website
to view this year’s posters.

COPE North American
Seminar 2015
COPE’s North American Seminar
was held Wednesday, August 19
OCTOBER 2015
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and covered the theme of understanding metrics in publishing.
David Crotty, Senior Editor
at Oxford University Press and
Scholarly Kitchen chef, kicked off
the seminar with a discussion on why
we need metrics and what new metrics can offer Editors and journals.
The debate continues on what is the
best way to measure the impact of a
journal or a particular article. Both
the Impact Factor and altmetrics are
flawed in their own ways and at the
end of the day, there is no substitute
for human judgement.
Elizabeth “Betsy” Donohue,
Vice President and Publisher
Business Development at Digital
Science, talked about altmetrics
in more detail, mentioning that
researchers can use altmetrics to
gauge the popularity of an article
and that altmetrics lets researchers
discover and network with others.
Publishers have been a key driving
force in the development of altmetrics, which can be used by Editorial
Offices to encourage submissions,
identify content, and determine
high-profile authors.
Finally, Todd Carpenter, Executive Director at National Information Standards Organization
(NISO), presented on NISO’s
initiative to explore and identify
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standards for alternative assessment metrics.
Although we have been using non–citation-based
metrics for decades, there has not been the technology to collect or analyze data until recently.
The NISO website contains more information
about their altmetrics initiative and a 2014 white
paper on phase 1 of the project.
After lunch, participants broke into groups to
discuss cases previously reviewed by COPE. Next,
the groups participated in an interactive workshop where they designed a new COPE flowchart
answering the question, “What to do when an
author appeals a review decision?”
More information on COPE can be found at
their website, http://publicationethics.org.

ISMTE North American Conference 2015
Thursday, August 20: Morning Plenary Session
Keynote Address: Scholarly Communication
Free-for-All: An Update on the Current State
of Predatory Publishing and Related Scams
Reported by Meghan McDevitt

ISMTE welcomed back Jeffrey Beall, from the
University of Colorado, Denver, to this year’s
North American conference. He began with an
overview of publishing models, from traditional
subscription-based models to Gold Open Access
(OA) where authors must pay a fee to publish,
before describing ways in which to identify predatory publishers—those that exploit the Gold OA
model for their own profit, taking advantage of
scholarly researchers. Predatory publishers can
provide cheap, easy, and fast publishing, leading
to a breakdown of the research culture and damaging science along the way.
There are many ways in which predatory publishers aim to look authentic, including posting ISSNs on websites, obtaining fake Impact
Factors, and hijacking legitimate journals to
deceive authors. Publishing in a predatory journal can pose risks to a researcher’s career, such
as harming his/her reputation. Beall concluded
that the author-pays model has been a major cultural change in scholarly publishing that has led
to the creation of scams and an upsurge in predatory publishers.

Thursday Morning Breakout Sessions
Session A: The Landscape of Predatory
Publishing: An Exploration of Concerns
Reported by Deborah Bowman, MFA, ELS,
Managing Editor, GIE: Gastrointestinal Endoscopy
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Donald Samulack, PhD, from Editage,
Jeffrey Beall, Hazel Newton from Nature
Publishing Group/Palgrave Macmillan, and
Gordon MacPherson, Director of Conference
Quality at IEEE, reported on predatory publishing. This session took the form of a question-and-answer format, with Samulack asking
the questions. A number of important ideas came
out of this session: (1) It is important to distinguish between predatory journals and legitimate
OA journals. (2) Some predatory publishers have
“ghost conferences” where people pay to be published in the conference proceedings, but then
they find out that there is no actual conference.
(3) Pressure to publish is driving much of predatory publishing (or “questionable” publishing,
as Beall’s lawyers prefer) because authors will do
whatever it takes to get their articles published
for the sake of their careers. (4) If you managed
to knock out one predatory publisher, three or
more would just spring up; therefore, it is going
to be impossible to get rid of them all. (5) Authors
choose a journal for submission based on many
factors, including the reputation of the journal,
the Impact Factor, its consistency, and whether
it progresses the science. It is extremely important, therefore, that we make sure our journals
fulfill all of these criteria if we hope to attract
reputable authors. (6) Predatory publishers
sometimes create a journal with the name of a
legitimate journal to fool people into thinking
that the journal is reputable. Editors should
search the Internet for their journal on a regular
basis to ensure that no one else is using their
name.
One very large benefit of scholarly publishing is that we are a community, but predatory
publishers threaten that. The only way to defeat
them is for authors to stop supporting them.
The panel members said that the future of science is at stake because these predatory journals
are contaminating the body of knowledge by
publishing articles without peer review or any
other kind of quality control. It is crucial for us,
as Editors, to be aware of this trend and to take
steps to guard against it.
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Session B: Best Practices vs. Legal Requirements:
What Every Editorial Office Needs to Know
Reported by Jan Higgins, Managing Editor,
Genetics in Medicine
Kathy Lyons, head of Editorial and Author
Services at Nature Publishing Group, first defined
a best practice and then went on to detail which are
the current relevant policies for journal Editors.
Those included authorship descriptions at ICMJE
and NIH’s recent checklist to improve study
reproducibility. She then explained how journals
can be compliant with those policies (e.g., using
CrossCheck to check articles for plagiarism).
Debra Parrish, an attorney who works with
institutions as well as publishers and researchers
on matters of research integrity, talked about the
legal liabilities we can sometimes encounter in the
Editorial Office. Her advice to avoid legal issues was
to follow the published guidelines from organizations such as CSE and COPE as these are the industry standards. She also recommended that journals
have public guidelines so authors and reviewers
know what is expected of them, and so that Editorial
Offices can refer to them if misconduct is alleged.
Session C: Doing More with Less: Help for
Small Journals
Reported by Steve Musser, Sales Representative, Sheridan
Judy Connors is the Associate Director for
Editorial Services at the Drug Information
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Association (DIA) and she shared her experiences
of doing more with less in small journal Editorial
Offices. Faced with a significant retirement of editorial staff, Connors was challenged to accomplish
a number of goals with a leaner editorial staff. This
included increasing the number of manuscript
submissions and citations, raising the Impact
Factor, boosting advertising sales, and driving
blog engagement.
Connors further explained the process by which
they undertook this challenge. First they identified needs for the publishing program, namely
developing a DIA knowledge center with publications at its core, and establishing continual sources
of current content. Second, they raised awareness
of the publications by partnering with publishers, incorporating social media marketing with an
internship program, and providing a business card
for editorial board members to spread the word.
Lastly it was time to take action. The DIA
strengthened their working editorial board using
publishers and volunteers to lighten the load.
They further established performance metrics
and a monthly reporting system, automating as
many of the tasks as possible. Marketing plans
were developed for the publications, including
social media in the form of a blog, podcasts, and a
Twitter presence.
Connors concluded by noting the importance
of setting a sustainable structure around editorial
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efforts by engaging volunteers, tracking metrics
closely, and automating as many tasks as possible.
She advised that communication is key; be prepared to make course corrections as needed since
nothing is perfect and don’t be afraid to spin content through different media channels.
Session A: Predatory Author Services: What
Can Be Done About It?
Reported by Deborah Bowman, MFA, ELS
In the continuation of the predatory publishing
session, Newton, Samulack, and Beall returned
and were joined by Josh Dahl from Thomson
Reuters. Samulack reiterated that we are at a
dangerous time in publishing history because of
predators. Unfortunately, the problems caused
by predatory publishers are not confined to postpublishing; rather, author services in the prepublication stages have attracted predators as well.
“Author services” includes all pre-submission
work, including pre-submission peer review, copyediting, and translations. Some of these service
companies are only too happy to take an author’s
money without doing any real work on his or her
article, or they charge exorbitant fees and agree
to work on poor-quality articles just to get the
author’s money. In addition, there are brokers
who, in exchange for a payment, promise authors
that their articles will get published. As a result,
science continues to be tainted with poor articles
that may be indistinguishable from good articles
to the average reader. Samulack said we are at a
tipping point in publishing history; publishing
itself as a reputable business is at stake.
This panel quoted Ginny Barbour (COPE
Chair), who has said we need a culture of responsibility for the integrity of the literature. Therefore,
the people on this panel are enacting a call to
action by starting the Coalition for Responsible
Publication Resources (CRPR). Their purpose is
to help preserve the integrity of scholarly literature by ensuring that author services are transparent and accountable so that all academic authors
can make informed decisions. The CRPR website
is now live, and they are eager for feedback on the
need for this coalition, which will vet and give the
stamp of approval to legitimate author services.
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Careers are being destroyed by predators, both
pre- and post-publication. CRPR wants to curb
this trend by educating authors and setting quality
standards. They welcome the support of anyone
who attended the ISMTE conference.

Thursday Afternoon Interactive Workshops
Session A: Advanced Tips and Tricks for Word
Reported by Stephanie Kinnan, Editorial Assistant,
GIE: Gastrointestinal Endoscopy
Martin Spiering of CSR Incorporated, a research
support company, discussed ways to improve the
way you work in Microsoft Word. He began by
stressing the importance of customizing your
toolbar or “ribbon” to your preferences, adding tools you use often and doing away with
those that get in your way. He referred to File
→ Options as Word’s “secret portal” where you
can customize everything from autocorrect to
grammar settings.
He also offered tips for dealing with multiple versions of the same document. Review →
Compare allows you to track the differences
between two similar pieces, while Review →
Combine helps merge the modifications made
by several contributors into one document.
Spiering warned, however, that simply accepting all changes in a document created with
the Combine function is unlikely to give good
results, so this feature is better for keeping track
of changes than for quickly creating a final,
revised document.
Other hints included going to File → Options
→ Proofing → Settings to activate a requirement
for a serial comma, using View → Split to split your
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screen to compare sections of your document, and
setting up Insert → Quick Parts → AutoText to
quickly insert stock phrases.
Finally, Spiering discussed the more advanced
trick of creating your own automated tasks
through the use of macros (View → Macros).
Macros can significantly cut down the time it takes
to complete certain tasks in Word. For example,
you can preprogram a frequently used comment
and simply click that macro to insert the comment
instead of typing it out at every use.
Overall, Spiering’s presentation was instructive
and engaging. He gave step-by-step instructions
for customizing the Microsoft Word user experience, leaving the session attendees equipped and
well informed.
Session B: Improving Your Instructions to
Authors
Reported by Steve Musser
Ashley Smith and Kurt Spurlock from Research
Square offered their thoughts on improving your
instructions for authors. Impediments to publishing can be frustrating to all people involved,
including authors and Editors. With the goal
of creating standardization and predictability,
Spurlock notes the audience for instructions is
researchers who want the submission process to
be as easy as possible and who view instructions as
a reference to consult.
To make guidelines easy to follow, Smith and
Spurlock suggest organizing information into
tables, building a checklist of required elements,
providing example citations and references and
placing this information on a single or central page
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with links to other guideline pages. They went on
to provide several “before and after” examples
which neatly demonstrated the effectiveness of the
table format.
Smith then shared her thoughts on figure formatting, noting that authors are frequently confused by terminology and procedures. To avoid
figure-related questions it’s best to avoid esoteric
terms and instead show examples and provide brief
instructions for specific procedures. Smith went
on to provide specific examples of common figure
formatting problems including image resolution,
figure dimensions, file types, and color space. The
session concluded with a collaborative discussion
where attendees shared their experiences, good
and bad, with each other.
Session C: Poster Research/Presentation Skills
Reported by Michelle English, Director of Operations,
J&J Editorial
The main takeaway of this session from all the
presenters was that creating a poster should not be
intimidating. Alethea Gerding, Managing Editor
of the Journal of Prosthodontics and Sara Welliver,
Client Manager/Systems Support Manager at J&J
Editorial, both spoke about their prior experience
creating and submitting posters at past ISMTE
conferences and stressed that if a topic is of interest to you then it is likely going to be interesting to your colleagues. Poster ideas don’t need to
be grueling research projects carried out over a
number of years—they can be about simple topics
or issues that are quantifiable. Presenter Margot
Puerta, an Executive Editor at the Feinstein
Institute for Medical Research, urged audience
members to think of the three most pressing issues
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in your Editorial Office, and then brainstorm ways
you could address those problems. If information
must be gathered to prepare the poster, consider
how could you do this (custom reports, spreadsheet tracking, etc.).
Each poster should be split into a few basic
parts: introduction, objectives/hypothesis, materials and methods, results, and a discussion/conclusion. The presenters split the audience into groups
to workshop some case study examples of issues
that an Editorial Office might face. The audience
was tasked with determining how a poster could
be created out of the information given. It seemed
like everyone walked away with some concrete
examples and inspiration for future poster submissions. The session closed out with helpful slides
and explanation by Puerta on how ISMTE members can submit an abstract proposal and create a
poster for next year’s conference. ISMTE has made
it especially easy for newbies who have never created a poster before by offering poster mentoring
and an easy to use drag-and-drop poster template.

Thursday Afternoon Breakout Sessions
Session A: The Publishing Environment in
China
Reported by Nijsje Dorman, Managing Editor,
American Journal of Kidney Diseases
Yan Shuai, Director of Journal Publishing at
Tsinghua University Press, gave attendees an inside
view of STM publishing in China. A key feature
is the prominent role of the central government
in publication practice. For instance, in 2014 a
government agency set criteria for academic journals. Currently 5,756 publications—sponsored by
a variety of research institutes, societies, and universities—are officially licensed as academic journals in China. But Chinese government ambitions
go far beyond regulating domestic STM publishing: there is a clear goal to support Chinese
journals instead of emphasizing publications
by Chinese authors in foreign journals. To that
end, there is direct government support for toptier journals such as Nano Research (copublished
by Tsinghua University Press and Springer; currently ranked number 11 in the “Nanoscience and
Nanotechnology” category of Thomson Reuters’
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Journal Citations Reports [JCR]), to make these
publications even more competitive internationally.
Similarly, the China Association for Science and
Technology (CAST), an umbrella group for scientific and technological societies, launched a project
in recent years to enhance the international prominence of China’s English-language journals, 163
of which are already included in the JCR. Chinabased journals are also focusing on recruiting top
international scientists to be Editors-in-Chief and
Associate Editors and on soliciting content from
conferences. In another effort to improve quality,
the Society of China University Journals (CUJS)
has launched an award for the best Chinese journal
and organizes international exchanges.
The session continued with a complementary perspective from Xianyong Yin, PhD, who conducted
genomics research in China for 10 years prior to
his recent hire as a research assistant professor at
the University of North Carolina, Chapel Hill. Yin
reminded attendees of the breathtaking rise in publications from Chinese authors, which by 2025 will
equal the research output from the United States.
He gave hints about how US journals can attract
high-quality submissions from Chinese authors by
explaining how he decides on the appropriate journal
for his work. In his view, the number one criterion
is the journal’s reputation, followed by the speediness of the review process (he likes an initial triage
decision within one week), whether it is OA (while
he prefers everyone to have access to his paper, he
adjusts the importance he ascribes to this based on
available funds), how quickly publication happens
(epub ahead of print is a must), and how well the
journal promotes the paper. In terms of promotion,
he mentioned Elsevier’s “My Research Dashboard”
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and CiteAlert services, which made him feel he was
able to effectively monitor the performance of his
papers. Yin highlighted three sources of information
for selecting journals: the JCR, the journal homepage, and a Chinese-language website, MedSci,
which provides crowdsourced journal reviews from
authors, including metrics such as average consideration times.
Session B: Alternative Article Types: Identifying
New Opportunities
Reported by George Woodward, Publisher, Elsevier
The aim of this session was to encourage attendees
to think beyond traditional article types and to consider novel options relevant to their specific fields.
Speakers Deborah Bowman, MFA, Managing
Editor of GIE: Gastrointestinal Endoscopy, and
Paige Shaklee, PhD, Publisher at Elsevier,
reported on their experiences in identifying opportunities and implementing new article types.
Bowman discussed GIE’s video articles, which
have proved so popular they are actually being
spun off into their own journal. Although it is
becoming fairly common for articles to be accompanied by supplemental videos, in this case the
video itself is the article. Given the use of video
technology in gastrointestinal endoscopy, these
articles are an excellent example of how a journal
can meet a need in its field by developing a publication outlet for materials that are already being
created during the research process. Bowman
noted that the articles do not have abstracts
because they did not want to risk them being
considered citable source items for the Impact
Factor. This decision may be revisited, as the
Impact Factor may not be a significant concern
for the new journal. Unexpectedly, the articles
are showing up in PubMed searches, although it
is not known whether this will continue.
Shaklee spoke about the publication of data
articles in the relatively new journal Data in Brief.
Data articles consist of descriptions of data—
without analysis—and either the data itself or a link
to a publicly accessible repository containing the
data. These articles benefit authors by providing
publication credit for the data itself, while fitting
with the trend of increasing author, institution,
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and funding body interest in making data more
easily available. Shaklee emphasized the cross-disciplinary nature of the journal, pointing out that
researchers would be able to take better advantage
of relevant data from another field, something
that is not currently easy to do. As this is still an
emerging area, Shaklee noted that there are still
many questions to be answered.
Both speakers spoke to the value of using
templates in establishing new article types, to help
guide authors through the formatting process and
to ensure that key elements were included.
Session C: New Technologies to Support
Editorial Office Operations
Reported by Kerry O’Rourke, Senior Managing
Editor at KWF Editorial Services
Change is a constant in scholarly journal publishing and it can be a challenge to keep current with
new technologies and tools that are launched continually. This session introduced three offerings
that many ISMTE meeting attendees may find
themselves using in the coming year.
Dryad

Dryad is a general-purpose data repository that
has been curated to make the data that underlie
scientific and medical publications more easily
discovered, reused, and cited. Executive Director
Meredith Morovati said authors generally agree
that data should be shared and reused and that
more and more funders are requiring researchers
to post their data publically.
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Dryad, a nonprofit based in Durham, North
Carolina, has developed technology to integrate the
process of submitting data to be archived into the
manuscript submission process. The system is flexible in order to meet varying journal data policies.
All data in Dryad is free to access and download.
“Data hoarding” is on the way out, Morovati said.
Dryad employees are involved in the data
curation process to perform a basic check when
data come in and to make sure that authors are
not uploading content that they shouldn’t be.
Morovati explained that each data set uploaded
receives its own DOI, which provides a permanent
link from the data to the article and back.
Morovati encouraged attendees to examine
their data policies and consider requiring authors
to submit data. “A simple workflow change can
produce big results,” she said.
Find more information at www.datadryad.org.
RightsLink for Open Access

RightsLink, a system from Copyright Clearance
Center that allows publishers to automate certain
transactions with authors and other stakeholders,
can be integrated into a journal’s workflow in a
number of ways. The system even can be used for
transactions that don’t involve money, said Director
of Business Development Chuck Hemenway.
With the growth of OA options, there is no
longer “one price fits all” for authors, which
means publishers must take a more active role in
making sure all institutional and funding requirements are met. “The new normal is there is no
normal,” Hemenway declared.
RightsLink is a robust, common platform that can
leverage the data provided by ORCID, FundRef, and
Ringgold, he explained. The system seeks to simplify
the fee process for authors and reduce the chance of
errors. It also has resulted in publishers being paid
faster, he noted. The system provides comprehensive reporting; publishers can pull every piece of data
about the transaction that they may need.
In addition to monetary transactions,
RightsLink can integrate marketing and promotional efforts about society membership, rewards,
and other services.
Find more information at www.copyright.com/
content/rightscentral/en.html.
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Aries Systems, which developed Editorial Manager
and ProduXion Manager, continuously works on
practical ways to integrate new technology and
tools into the peer-review workflow, said Director
of Strategic Client Solutions Jennifer Fleet. The
peer-review system is a “central hub” and a logical
point to integrate new tools, she noted.
For example, users can log in to Editorial
Manager with their ORCiDs. The technology is
such that an author’s ORCID username and password are never exposed to Aries.
The Dryad system is integrated into Editorial
Manager and allows authors to upload the URL
where their data resides with their manuscript.
The live link to the data becomes part of the submission PDF and reviewers and editors can click
through to access the data, Fleet said.
Editorial Manager also has integrated the
RightsLink system for article processing charges.
As Fleet described, if authors want to submit
a paper for OA publication, they simply click a
button and the system will estimate the charge
for them. Editorial Manager feeds information
about the manuscript into RightsLink to create
the estimate. Once the article has been accepted
or another trigger event occurs, authors receive a
deep link that takes them into the RightsLink payment system. Payment processing occurs outside
of Editorial Manager, Fleet explained.
Find more information at www.editorial
manager.com.
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Alice Northover, the Social Media Marketing
Manager for Oxford University Press, opened the
discussion with an overview of several common
marketing tools. She discussed some of the advantages and challenges of public relations, social
media, paid advertising, and direct marketing.
Northover reminded attendees that “free” marketing still has a cost in terms of time and staffing.
Even with limited resources, however, any journal office has the opportunity to promote its content. Northover also discussed how a journal can
benefit from conferences and leveraging existing
partnerships.
Charlie Rapple, the Sales and Marketing
Director of Kudos, then presented on working
with authors promote their own content. She
pointed out that authors frequently know their
community better than outsiders, providing an
advantage for locating an appropriate audience
and identifying the “story” that will capture their
interest. The journal office can encourage authors
to promote their own work by demonstrating the
return on their invested efforts. Trackable links,
mentions, altmetrics, views, downloads, and citations are just a few of the tools that journal offices
can use to measure promotion.
Both speakers emphasized the importance of
clearly defined goals. Identifying the key message
and target audience can help the journal office
make the most of limited resources. With a number of tools at their disposal, attendees can experiment with promotion and adapt their strategies
as needed.

Friday, August 21: Vendor Sessions
Breakout sessions were held Friday morning for
eJournalPress, ScholarOne, Editorial Manager,
and Elsevier’s EES/EVISE, covering new and
upcoming features across editorial systems.

Friday Breakout Sessions
Session A: Public Relations for Journals and
Helping Authors Promote Their Work
Reported by Sarah Forgeng, Editorial Process
Manager, Journal of Investigative Dermatology
This session focused on the challenges and
opportunities for promoting journal content.
OCTOBER 2015
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Session B: Pre-Submission Vendor Space:
Selecting Great Partners
Reported by Jessica Rucker, Manager of Peer Review
Systems, American Chemical Society
The panel, hosted by Charley Trowbridge,
Director of ACS Publications, treated the audience to a high-level overview of current activity
in the pre-submission vendor space. Trowbridge
warmed up the discussion by encouraging
publishers of every size to consider their vendor needs in this growing pre-submission sector, focusing on the high cost of learning what
authors need and developing internal resources
to meet those needs. The three panelists shared
information on the author services their respective companies provide, and suggested some
key considerations that publishers and societies
should make before selecting a pre-submission
vendor partner.
Shawn Maloney, PhD, Co-Founder and
President of Journal Prep, kicked off the panel by
honing in on the difference between what authors
want versus what authors will pay for and the
importance of knowing where to position your
services. Maloney also addressed the emerging
desire for statistical analysis in certain fields of scientific and medical writing.
Deric Corlew, PhD, Vice President of Business
Development at Research Square, made important distinctions between author challenges and
journal needs, underscoring the importance of

10

Editorial Office News

understanding a publisher’s goals before selecting
a vendor partner. Corlew also provided the audience with a very clear overview of the different
flavors of partnership, from private labeling to
referral programs.
Donald Samulack, PhD, President of US
Operations for Editage, wrapped up the panel with
insights into the value of partnering with a large
international firm, especially one that has experience working in the Asian markets. Samulack
shared his experience working in China, where the
demand for author services is as high as their desire
to publish in high-impact international journals.
Session C: Ethics: The Practical Application
of Journal Policies and Cases That Challenge
Them
Reported by Jen Mahar, Origin Editorial
Heather Goodell, Director of Scientific
Publishing at the American Heart Association
(AHA) and Debra Parrish, an attorney with
expertise in the field of publishing, spoke about
how to apply ethical policies into your workflow
when handling cases involving integrity issues.
They used a series of cases of authorship, editor
conflict scenarios, and retraction issues showing
the need to look closely at policy when considering how to handle such cases. Both speakers
shared cases that explored where policy could be
enforced or changed to more fully cover situations
when they arise.
Goodell led her discussion by discussing development of ethics policies (following COPE, CSE,
and ICMJE guidelines as best practices), but
stressed that you often are taken off the beaten
path of the documented process due to the complexity and nature of each case. The AHA provides
their ethical guidelines online as a resource and as
a place to point authors, Editors, reviewers, and
the media. Goodell described a few cases where
her stated policy was tested. The first was related
to an AWOL author’s paper that was eventually
rejected. She stressed the importance of emailing
all authors correspondence related to a paper and
discussed staffing implications to any change in
your workflow.
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Goodell then went on to discuss a case in which
an author published a paper without his principal investigator’s knowledge or participation.
Although it was agreed that it was bad form for
the author to publish the paper, when the procedures and policies were reviewed, the journal
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concluded there was nothing more that could be
done because the author had legitimate access to
the data and the paper met journal requirements
for publication.
Her third scenario revolved around a published conference abstract. The author who
uploaded and submitted the original abstract
was not present at the meeting and another
author took over. The original author claimed
identity theft. Goodell stressed the importance
of determining who signs the copyright transfer
agreements for abstracts and what type of security might be needed during the conference to
check that the author who signed the form is the
one who uploads the slides. Journals might also
consider publishing abstracts after the meeting,
instead of in tandem with it. Goodell pointed
out that there are also staffing implications to
many of these considerations.
Finally Goodell discussed ethical concerns
about policies as they relate to Editors and the
appearance of any ethical concerns. She stressed
the importance of having a workflow when an
Editor is involved in an allegation of misconduct. You should have a set structure for where
the manuscript should be sent and who should
be informed and act as Editor for the paper in
question. One important aspect to journal policies should address is obtaining conflict-of-interest information on your Editors so that there
can be some review of what else the Editors are
involved with to determine if there is conflict or
concern with a submission. Goodell mentioned
that if you use Guest Editors, you should have

Congratulations to the 2015 ISMTE Award Winners!
ISMTE Award for Excellence
Mary L. Chang
Publications Manager, American Society for Biochemistry and Molecular Biology
ISMTE Award for Achievement or Innovation
Tim Vines
Managing Editor, Molecular Ecology
ISMTE Jason Roberts Founder’s Award
Elizabeth Blalock
Managing Editor, Journal of Investigative Dermatology
OCTOBER 2015
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a policy and workflow for their involvement in
your journal.
Goodell had many practical angles for how to
handle when your policy is challenged by your
workflow or when your workflow is challenged by
your policy.
Parrish posed a case that would test any retraction policy—a high-profile author who was unable
to provide the underlying data for many published
studies. After outlining the case, she posed questions to the audience about retracting the papers.
Parrish reviewed how institutions and universities
handled the cases, pointing out that there was a
finding of misconduct by at least one institution
and a pattern of misconduct on the part of the
author (for being unable to provide data and for
destroying materials). However, another institution the author worked at did not make a finding
of misconduct.
Parrish went on to note that the COPE guidelines advise that you should be justified to retract
if it is clear that findings are unreliable or after an
institutional investigation has found misconduct is
present. A journal can retract even without author
agreement. She stressed it is important for journals
to understand that it is the institutions’ responsibility to perform these investigations, not the
journals; journals typically do not have these types
of resources or access to authors or data. A university should have a system in place for management
of ethical concerns for its faculty. But there are
variations by country and institution and if you are
dealing with a non–US-based university, you may
find that their practices are very different. Parrish
detailed how each of the institutions handled the
finding of misconduct and the involvement of
co-authors, which ranged from agreeing to retract
to disagreeing strongly. One co-author feared
being sued by the accused author if she agreed
to retract, although she was aware the data were
likely fabricated.
Parrish gave the audience many things to think
about when approaching a potential retraction,
emphasizing that your journal should have a system in place for handing retractions. Retractions
are corrections to the literature and should be
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detailed in the information you provide about
your journal.

Friday Afternoon Plenary Session
Plenary Address: Science out of the Box
Reported by Michelle English
Audrey Huang, MA, PhD, Director of Marketing
and Communications for Research and Education
at Johns Hopkins, closed out this year’s conference with a plenary address about communicating
science to the public. Huang explained that her
background in research and science writing is what
brought her to her current position at Hopkins,
with her main goal being to help the institution
recruit the very best educators and trainees from
around the world. While previously the school’s
marketing and communications used traditional
print forms, it’s been a new challenge to figure out
how to communicate with and attract incoming
medical students who are of the iPhone generation. The “Science Out of the Box” program was
launched a little over a year ago to increase the
social media presence surrounding the scientific
research programs at Hopkins and offer something that would appeal to a very broad audience.
The audience was able to watch a few Science
Out of the Box YouTube videos. In each, a
researcher was given a box of toys and used those
toys to explain the science behind their findings and
core research initiatives. In one video, a researcher
used building blocks and rope to explain how protein chains are affected by cell signaling. In another,
a string quartet was used by a doctor to explain
cancer epigenetics—with instruments playing in
and out of unison to tell the story of cells turned
cancerous.
Huang explained that these days researchers
have many groups that might potentially care about
what a laboratory is doing: peers, students, policy
makers, grant funders, general news media, philanthropists, and so on. Each group comes to the table
with a very different knowledge base, so the goal
was to find a way to translate what the researchers are doing for nonexperts. Each video’s focus
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tries to be a bit broad, and to contextualize the
very specific science being done by one researcher
to a more relatable or practical application. Using
toys helps to cut through the highly technical jargon that experts sometimes tend to use, and makes
the language simple and the applications relatable.
Huang said that filming each short video typically
takes two to three hours and that it can only be
successful if the researcher is actually comfortable
in front of a camera playing with toys. Check out
the Science Out of the Box videos by visiting their
YouTube channel.

Conference Wrap-up
Congratulations to Elizabeth Blalock and the
rest of the conference planning committee,
Michelle English, Jessica Rucker, Kurt Spurlock,
Steve Musser, Julie Nash, Sarah Forgeng,
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Kerry O’Rourke, Margot Puerta, and George
Woodward, for the excellent planning and execution of another great ISMTE North American
Conference.
Thank you to our Conference Sponsors:
Aries Systems, Asian Council of Science Editors,
Cabell’s International, Council of Science Editors,
Copyright Clearance Center, Editage, J&J
Editorial, Springer, and Wiley.
View handouts and conference materials from
the meeting online at the ISMTE website.
Hope to see you next year, when we’ll be back in
Philadelphia, Pennsylvania, August 11-12, 2016.

Editor’s Note: Photos courtesy of Kristie
Overstreet, Carolyn deCourt, Michael Willis, and
Meghan McDevitt.

ISMTE Upcoming Conferences

2016 Asian Conference

4–5 April 2016
“Best Practices in Scholarly Publishing”
Novotel Singapore Clarke Quay
Singapore
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2016 North American
Conference

11–12 August 2016
Hilton Philadelphia City Avenue
Philadelphia, Pennsylvania, USA

www.ismte.org
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The Best of Both Worlds
By Jennifer Deyton
Senior Partner
J&J Editorial, LLC (www.jjeditorial.com)
Jennifer@jjeditorial.com

Several years ago, I was asked to write an article
for EON on remote management of the Editorial
Office.1 As a senior partner for what at the time
was a very small band of contractors specializing in professional peer review, I was proud to
tout the benefits of working from home as our
Managing Editor profession developed into
something more permanent that could be done
off-site from the publisher, society, and university. We worked very closely with Managing
Editors and as Managing Editors to serve a few
publisher and society journals located in other
parts of the country. The article I wrote gave
tips and tricks on working remotely and mainly
focused on the remote relationships with Editors,
publishers, and societies. A handful of us worked
together to manage a handful of titles from our
home offices. We often met in cafes and collaborated via instant messaging, email, phone, etc. At
that time, technology and the changing landscape
of academic peer review enabled us to professionalize the role of the Managing Editor without the
need for overhead such as rent, utilities, furniture,
and other expenses related to managing a brickand-
mortar office. We were very successful as
Managing Editors working from home, just like
most of you are still today.
Fast forward seven years, and I was asked
again by EON to address this topic in the “modern” world now that remote management of the
Editorial Office is not such a novel idea. Online
submission systems like ScholarOne, Editorial
Manager, and eJournal Press have propelled this
profession into the twenty-first century. Of course,

1

Deyton J. Remote management of the editorial
office. EON. 2008;1(5):11–12.

OCTOBER 2015

J&J still has clients all over the globe and continues to function as Managing Editors from remote
locations on behalf of our clients. However, as we
have grown, I have less advice on how to manage
a growing staff working out of home offices. On
the contrary, what I have found and would like to
share here is that as our small band of independent
Managing Editors has morphed in a growing professional company of almost 70 full-time employees with benefits and human resources needs, the
partners and management at J&J really feel the
need to have a presence in a brick-and-
mortar
office. Do not get me wrong, I do still think this
job can be done from anywhere, and so we allow
all employees to work from home one to two days
a week. However, in order for us to fully optimize
our skills, share experiences, and collaborate in
such a way as to offer our clients the most professional peer-review management possible, we have
found we need a “command center” and have
begun to put more and more emphasis on our
company structure.
In January of 2014, J&J converted all contractors to employees. In doing so, we felt we would
be able to better recruit and retain professional
Managing Editors focused on a career in academic
peer-review management. We now offer a robust
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benefits plan that includes vacation, sick time,
professional development, and health insurance,
among many other benefits.
J&J has also developed a management structure
to help ensure effective communication, professional development, and collaboration. In addition to the two original partners, we also have a
director of operations who manages all aspects
of the office, our recent expansion into a new
suite, computer needs, human resources, hiring,
and everything else that helps us maintain the
best Managing Editors possible. We have also
appointed coordinators for each of our four areas
of focus: peer review, production, copyediting,
and system support. Each publisher also has a client manager reporting to their respective coordinators who oversees the needs of that particular
client and manages the Managing Editors and
Editorial Assistants working in that department.
As we have grown and developed a management structure, our employee-based company
really needs traditional office space and hours to
properly function as a cohesive organization.
As I mentioned, we do allow all employees at
J&J the opportunity to set their schedule and
work from home up to two days a week. However,
we have found over the years that we are able to
offer a better service to our clients, as well as a
more engaging company atmosphere for our
employees, if we have office hour times together
as an organization. Although there are countless
benefits to working from home, like saving on
commute time, saving gas money, and saving the
environment, to name a few, working as an independent Managing Editor can often be a slightly
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isolating profession, especially if you work from
home in a different state than your publisher,
Editor-in-Chief, and society. Our focus over the
last few years has been to develop a company that
not only better serves our clients, but contributes
to the original mission of J&J to professionalize
the role of Managing Editor and other professions
involved in managing successful peer-reviewed
journals. We feel our employees gain great insight
from each other when they have face-to-face
time to collaborate and exchange ideas. Carolyn
deCourt, a J&J Managing Editor who works with
the American Chemical Society, explains it best:
Most days I prefer coming into the office, because
I feel I'm more motivated being surrounded by
other working bodies, and I am more likely to
be able to help out with other projects around
the office. It is easier to communicate thoughts
with my team and is great for team bonding!
Working from home is always a nice change of
pace, and allows you to focus without the hustle
of the office. In the case of sickness or a family
emergency, it's great to have the option to work
from home to take care of things while being
able to complete your daily tasks at the same
time. The happy medium between the two keeps
me from getting burned out at one or the other.
Our evolution to a brick-and-mortar office also
helps to keep all our employees abreast of important and pressing issues in the publishing world.
For example, when we send 10-12 employees
to the ISMTE annual conference, we ask them
to then report on their favorite sessions at the
next J&J staff meeting. In this way, everyone
learns about predatory publishers, COPE, system upgrades, poster topics, standards initiatives
like ORCID, CRediT, and Ringgold, and other
hot topics in STM publishing. J&J sends several
staff to all the major meetings, including those
of the Council of Science Editors, the Society
for Scholarly Publishing, and the Association of
Learned and Professional Society Publishers, as
well as editorial management software user conferences, and many more. Then we bring back the
topical and informative sessions to the company
as a whole.
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Our ability to have staff meetings, department
meetings, and management meetings in our conference room allows for better collaboration, training, oversight, coverage, and a sense of community
for our employees. Without our office presence,
we feel this sort of industry growth would be more
challenging for a company our size. Our abilities to
work from home, set our own schedules, and work
autonomously on our own titles are usually considered benefits and are easy enough to do, as there is
a lot of flexibility in this profession. What we have
found as a company is that the right balance of
company office hours and home office hours gives
our employees the best of both worlds.

Kat Farley, a J&J Production Editor for PLOS
copyediting sums up our current situation quite
nicely:
In this field, it’s easy to get bogged down in isolated processes and day-to-day tasks. We’re all only
responsible for one or two pieces of an immense
publishing puzzle, and staff and department
meetings help us keep the big picture in mind. All
of our teambuilding happens in the office, and I
believe it’s strength as a team that makes us able
to meet and exceed our clients’ needs and expectations. However, your work wardrobe might
become a weird mix of pajamas and blazers.

Stay Connected through ISMTE’s Discussion Forum
Forums are threaded ongoing discussions that allow users to ask questions and have conversations
on various topics.
You can subscribe to a forum digest that will send a single email containing all recent forum
activity. If you want to be alerted immediately about forum activity, you can subscribe to a specific
forum or to a specific forum topic to be notified of new replies that have just been posted.
Visit the ISMTE website to subscribe to the Discussion Forum or contact Deborah Bowman
for more information.
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Discovering Our Roots: Monster Mash
By Stephanie Kinnan
Editorial Assistant
GIE: Gastrointestinal Endoscopy
It’s October 31st, Halloween, All Hallows’ Eve, and you’re too
old for trick-or-treating. So what do you do? Curl up on the couch
with a mug of apple cider and an entire bag of fun-sized Snickers®
(the trick-or-treaters can fend for themselves, you’re not sharing)
and watch a good old-fashioned horror movie. Nothing’s better than the classics, right? What screams Halloween more than
“redrum, redrum,” projectile green vomit, a shadow behind a
shower curtain, or a bucket of blood on prom night? But what
about the real classics? I’m talking about the old Hollywood
monster movies, ripped right from the pages of iconic literature.
Believe it or not, before vampires sparkled in the sunlight and
werewolves became teen heartthrobs, monsters were meant to be
scary, and no two more so than Dracula and Frankenstein’s monster. We all know they’re fiction, just characters adapted from old
books, but they still raise the hair on the back of our necks and
make us jump with every knock at the door. The slicked hair and billowing black cape, the scared
face and bulging neck bolts, Hollywood sure knew how to paint a picture, but did they get it right?
In honor of Halloween, let’s take a closer look at the things you thought you knew about two of
literature’s creepiest creatures.
Dracula:
The first movie adaptation featuring Dracula was released in 1931, and while that film certainly
left a lasting impression, it set a precedent for countless followers to stray from Bram Stoker’s
original vision. Most people will never pick up a copy of Dracula and so sadly will never learn the
truth of the vampire that launched a thousand franchises. Believe it or not, Dracula is actually
the result of a crab-and-mayonnaise-fueled nightmare that Stoker experienced after an evening of
overindulgence. Like a nightmare, this character was meant to be hideous and terrifying. Stoker’s
Dracula was certainly no love story. The vampire wasn’t so easy to kill either. A stake through
the heart wasn’t going to get the job done. According to Stoker, the way to ensure the death of
a vampire is to take off his head—talk about gruesome. Although the biggest vampire myth that
resulted from Dracula movie adaptations was the aversion to sunlight, Stoker’s Dracula was perfectly able to walk around during the day. He certainly didn’t sparkle in the sunlight and you
probably wouldn’t find him on a beach somewhere sipping a piña colada, but nor did he burst into
flames at first light. Although, I guess it makes for a much more theatrical death when the first
beams of sunrise turn a vampire to dust.
Image credit: “Bela Lugosi as Dracula, anonymous photograph from 1931, Universal Studios” Licensed under
Public Domain via Wikimedia Commons - https://commons.wikimedia.org/wiki/File:Bela_Lugosi_as_
Dracula,_anonymous_photograph_from_1931,_Universal_Studios.jpg
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Frankenstein:
Mary Shelley’s Frankenstein was also the product of a nightmare in which Shelley saw a corpse
coming back to life, and when her friend Lord Byron suggested a contest to see who could write
the greatest horror story, Frankenstein’s monster was born (or created may be a more appropriate
word). Movie adaptations of Frankenstein are also littered with inaccuracies, the most glaring of
which is the name itself. Frankenstein is the name of the creator, not the creation. The narrative
is really centered on the scientist Dr. Frankenstein, not his monster. And anyone who has actually picked up the book can tell you to forget about Igor or any other hunchbacked assistant. Dr.
Frankenstein did his twisted experiments alone, experiments that were far more successful in the
book than in any movie. Although he is rarely portrayed as such, what with all the grunting and
stiff-arm zombie-walking, Shelley’s monster was actually an intelligent being who could read and
write, although an educated zombie probably didn’t lend itself well to movie magic.
Adapted in part from:
1. Vigliotti, Jake. 10 Things You Never Knew About Frankenstein’s Monster. LISTVERSE.
http://listverse.com/2013/10/29/10-things-you-never-knew-about-frankensteins-
monster. Accessed August 16, 2015.
2. 15 Things You (Probably) Didn't Know About Dracula. ShortList. http://www.shortlist.
com/entertainment/books/15-things-you-probably-didnt-know-about-dracula. Accessed
August 16, 2015.
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Peer-to-Peer Content Distribution
By Joe Wikert
Director of Strategy and Business Development
Olive Software

Editor’s Note: This text was originally posted on
July 20, 2015 on Joe Wikert’s Digital Content
Strategies. It has been adapted and republished with
permission. Click here to view the original.
The smartwatch movement inspired me recently,
which is surprising because I haven’t worn a watch
since I started carrying a smartphone many years
ago. I’m about as far as you can get from being a
fashionista and I liken a watch to other obsolete
single-use devices like the GPS. I doubt I’ll buy
one anytime soon but I believe the device synchronization model used by smartwatches lends
itself to content distribution as well.
You’re probably aware of how most smartwatches
get paired with your smartphone. Although they
don’t have all the capabilities of a smartphone,
things like text messages and phone calls can be
redirected from your phone to your watch, thanks
in large part to Bluetooth technology. Your phone
communicates with your watch the same way your
phone connects with a wireless headset or desktop
Bluetooth speaker, for example.
Let’s fast-forward to the day when we’ve all
become peer-to-peer content distributors. Rather
than relying on centrally-managed and hosted
sites and services that handle everything from
reviews to downloads, this peer-to-peer model
means we’re doing all that for each other using
Bluetooth or some other simple networking protocols. For example, your phone or computer can
easily be turned into a Wi-Fi server, allowing you
to connect multiple devices to it; that’s a capability that exists today and I’m suggesting it could be
extended for new uses in the future.
The Kindle introduced a whole new level of
reading privacy. Once upon a time on a crowded
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bus you could see the cover of the book being
read by the person across the aisle. Now we’re
all masking our reading habits with tablets and
phones. No, I’m not suggesting we embrace an
overly intrusive model that has privacy advocates
screaming in the streets. Rather, I believe a peerto-peer model could be used to improve discovery
and consumption at the hyperlocal level.
Think of the hundreds of riders on a commuter train each morning. Maybe they’re traveling from the northern suburbs into Manhattan.
Some of them are neighbors. Many of them are
businesspeople. All of them probably follow and
read some type of news. Instead of just knowing
the top global trends on Google, wouldn’t it be
interesting to know what news stories your fellow
commuters are reading?
The same concept can be applied to passengers
on a plane or even homeowners in a neighborhood. Just as NextDoor.com has disrupted Angie’s
List and brought communication and recommendations to the local level, I suggest a peer-to-peer
model could do the same for content.
The peer-to-peer aspect really shines when
you consider how the content gets from my
device to yours. That news story I just read on
TheGuardian.com still lives in my browser’s
cache. If enough of my fellow commuters read
the same article, it floats to the top of the popular
news list for our little commuter community. You
click the link to it in our peer-to-peer content app
and the article is pulled from my cache to your
device.
In short, we’re distributing content to each
other, without having to go up and down, to
and from a central server. Wouldn’t this be terrific on a 4-hour flight with no Wi-Fi? Each of our
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devices acts as a mini-server, hosting content for
everyone else.
Publishers would freak out over this model, at
least initially. They’ll no longer control distribution and it will create holes in their analytics. I’m
sure most, if not all, publishers have something
buried in their terms and conditions preventing
this sort of thing, but those who want to embrace
broader distribution and consumption will eventually warm up to it.
By the way, the model isn’t limited to Web
pages. Think about the benefits this offers the
book publishing sector. What if you could see a list
of the popular e-books in your neighborhood or
among your fellow commuters? And what if you
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could pull a sample of one of those popular titles
from someone else’s device, again, a particularly
useful solution when you’re outside Wi-Fi and
cellular range? If you decide you like that sample
and you end up buying the e-book your peer-topeer commuter friend gets credit for the sale with
an affiliate cut of the resulting transaction.
We place way too much emphasis on the ability to measure global trends. You see it every day
on Google, Twitter, etc. While we all care about
these global trends, we’re also keenly interested
in local and hyper-local trends. This peer-to-peer
model addresses that point while also providing
some relief for data plan limits and spotty Wi-Fi
coverage.
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Changes in authorship
(b) Corresponding author requests removal of author before publication

Clarify reason for change in authorship

Note: Most important
to check with the
author(s) whose
name(s) is/are being
removed from the
paper and get their
agreement in writing

Check that all authors consent to
removal of author

Authors do not agree

All authors agree

Amend author list and contributor
details (role of each author/contributor/
acknowledgments as required)

Suspend review/publication of paper until
authorship has been agreed
Inform excluded author(s) that if they wish
to pursue the matter they should do this
with their co-authors or institutions rather
than the editor

Proceed with review/publication

Developed for COPE
by Liz Wager of
Sideview
(www.lizwager.com)
© 2013 Committee on
Publication Ethics
First published 2006
A non-exclusive
licence to reproduce
these flowcharts may
be applied for by
writing to:
cope_administrator@
publicationethics.org

publicationethics.org
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Calendar of Events
ISMTE European Conference & COPE Meeting
October 13, 2015
Heathrow, Middlesex, United Kingdom
www.ismte.org
EASE and COPE members receive ISMTE
member registration rate
2015 Mediterranean Editors and Translators
Meeting
October 29-31, 2015
Coimbra, Portugal
www.metmeetings.org
ISMTE Chicagoland Local Group
November 4, 2015
Chicago, Illinois
www.ismte.org

Publication Ethics: Fraud and Misconduct
November 17, 2015
London, United Kingdom
www.alpsp.org

Platinum Supporter
Wiley

Silver Supporters

Bronze Supporters

The RFP Process
December 9, 2015
Philadelphia, Pennsylvania
www.alpsp.org
ISMTE Oxford Local Group
January 28, 2016
Oxford, United Kingdom
www.ismte.org
ISMTE Asian Conference
April 4-5, 2016
Singapore
www.ismte.org
EASE and COPE members receive ISMTE
member registration rate
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to our Corporate Members!

ACS Publications
American Institute of Physics
Origin Editorial
Wolters Kluwer Health
Nature Publishing Group

Editing Medical Journals - Short Course
November 4-6, 2015
Oxford, United Kingdom
www.pspconsulting.org

2016 CSE Annual Meeting
May 14-17, 2016
Denver, Colorado
www.councilscienceeditors.org

Thank You

Aries Systems Corporation, Editage,
eJournalPress, J & J Editorial, LLC,
Oxford University Press (OUP),
Thomson Reuters, Technica Editorial,
Editorial Office Ltd, Elsevier,
Salient Content,
Cabell’s International,
Taylor & Francis

Interested in supporting ISMTE?
Please visit our Corporate Support page
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